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Introduction 
 

About CommView Remote Agent 
 
CommView Remote Agent is an application for remote network traffic monitoring. It allows CommView users to capture network 
traffic on any computer where Remote Agent is running, regardless of the computer's physical location. This new, unique 
technology broadens your horizons: you are no longer limited by your LAN segment or personal computer. If you are in Tokyo and 
want to troubleshoot a complex software installation in Amsterdam, just install CommView Remote Agent on the target system and 
watch the important TCP/IP traffic from the comfort of your office, as if you were there! 
 
After the installation and simple configuration, CommView Remote Agent is ready to accept connections from CommView. Once the 
connection is established and the authentication is successful, CommView Remote Agent is ready to capture packets in its network 
segment and transmit them to CommView. The transmitted packets are compressed to save bandwidth and encrypted to ensure 
safe transmission over insecure network channels. CommView has a flexible system of filters that is capable of filtering out all 
undesired packets, thus minimizing the bandwidth used for the TCP link between CommView and CommView Remote Agent.  
 
CommView Remote Agent is an indispensable tool for networking, software, and security professionals that can solve a wide range 
of problems, such as monitoring multi-segment LANs or remote software and network troubleshooting. 
 
CommView Remote Agent requires an Ethernet or Wireless Ethernet network card supporting the NDIS 3.0 driver standard, or a 
standard dial-up adapter. 
 



 
What's New 
 
 
Version 2.1 
 

• Windows Vista support. 
 
Version 2.0 
 

• High resolution time stamping (up to microseconds, available under Windows 2000/XP/2003). 
• Windows XP 64-bit Edition on AMD processors is now supported. 
• You can now capture loopback packets being sent from/to local IP addresses, e.g. 127.0.0.1 (this functionality is available 

under Windows 2000/XP/2003). 
• Improved performance. 

 
Version 1.1 
 

• This is a maintenance release where we fixed known bugs found in the previous versions and improved Windows .NET 
compatibility. This release also updates the driver to ensure compatibility with the latest CommView version and other 
products to be released soon. 

 
 



 

License Agreement 
 
Please read the following terms and conditions carefully before using this software. Your use of this software indicates your 
acceptance of this license agreement. If you do not agree with the terms of this license, you must remove this software from your 
storage devices and cease to use the product. 
 
Copyright 
This software is copyrighted 2001-2006, TamoSoft. CommView Remote Agent is a trademark of TamoSoft. The use and copyright of 
this software is governed by international copyright treaties. TamoSoft retains full title and rights to this software and 
documentation, and in no way does the license granted diminish the intellectual property rights of TamoSoft. You must not 
redistribute the registration codes provided, on paper, electronically, or in any other form. 
 
Evaluation Version 
This is not free software. You are hereby licensed to use this software for evaluation purposes without charge for a period of 30 
days. Using this software after the evaluation period violates copyright laws and may result in severe civil and criminal penalties.  
 
Registered Version 
A single computer license grants you the right to install and use the program on one computer. If you need to install the program 
on multiple computers, you need to purchase a multi-computer license.  
 
Disclaimer 
TAMOSOFT DOES NOT WARRANT THAT THE PRODUCT IS ERROR FREE. THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  IN NO EVENT WILL TAMOSOFT BE LIABLE TO YOU FOR ANY 
DAMAGES, INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING FROM THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT, 
AND AGREE TO BE BOUND BY ITS TERMS.  
 
Governing Law 
This Agreement will be governed by the laws of New Zealand. 
 
Distribution 
This software may be distributed freely in its original unmodified and unregistered form. The distribution must include all files of its 
original distribution. Distributors may not charge any money for it. Anyone distributing this software for any kind of remuneration 
must first contact us for authorization. 
 
Other Restrictions 
You may not modify, reverse engineer, decompile, or disassemble this software in any way, including changing or removing any 
messages or windows. 
 



 

Using the Program 
 

Installation and Configuration 
 
CommView Remote Agent should be installed on the compute(s) whose traffic you would like to monitor. Just like CommView, the 
agent can capture all traffic that passes through a network interface card (NIC) or dial-up adapter. CommView Remote Agent can 
be installed on computers that are part of a LAN or on stand-alone computers. You must have administrative privileges to install the 
program, although such privileges are no longer required after the initial installation and configuration. You should NOT install both 
CommView and CommView Remote Agent on the same computer; doing so makes no sense. 
 
Installation 
 
To install the program, run SETUP.EXE and follow the instructions on the screen. Once the program files are copied to the 
destination folder, you will see the Installation and Configuration window that will prompt you to enter two initial settings. You 
should select a TCP port number and password. The TCP port number (5050 by default) will be used by the program to accept 
client connections from CommView. The password is required for client authentication and subsequent packet encryption. Be sure 
to choose a long, hard-to-guess password, using alphanumeric upper and lower case characters, because if somebody guesses your 
password, he/she will be able to gain access to the network traffic of the computer on which you are installing CommView Remote 
Agent. 
 

 
 
Click Next to continue, and the program will install the necessary drivers and launch CommView Remote Agent for the first time.  
 
Batch Mode Installation 
 
When performing mass deployment of CommView Remote Agent, batch mode installation and configuration can be used. In batch 
mode installation, the required installation parameters are supplied as command line switches, and the installation process is 
performed silently, without any user interaction. To perform batch installation, SETUP.EXE must be run with the following switches: 
 
/s – silent installation. This switch is required. 
/port=xxx – port number, where xxx is any numeric value between 1 and 65536. This switch is required. 
/pass="xxx" – password, where xxx is a password string. The password string must be enclosed in quotation marks. This switch is 
required. 
/du – installs the driver for monitoring the dial-up adapter in addition to the standard set of drivers. This switch is optional. Do not 
use this switch if you don't need to monitor dial-up connections. Note that depending on the target system driver installation policy, 
you may be prompted to confirm this driver installation manually, so the installation process may not be silent.  
/lb – installs the driver for monitoring loopback packets being sent from/to local IP addresses, e.g. 127.0.0.1. This switch is 
optional. Do not use this switch if you don't need to capture loopback traffic. 
 
Usage example: 
 
SETUP.EXE /s /port=5050 /pass="ZdU34 ! Hny536" /lb 
 
 



Interface 
 
Once the installation and initial configuration has been completed, the program's icon should appear in the system tray as shown 
below. Clicking on the icon will bring up the application window that displays the program status – the port number that the 
CommView Remote Agent listens on, the IP address of a client that is connected to it, packet transmission statistics, and buffer 
utilization. 
 

 
 
Main Menu 
 
File 
 
Start/Resume Service – starts or resumes CommView Remote Agent service if it has been stopped or paused. 
Stop Service – stops CommView Remote Agent service. 
Pause Service – pauses the Remote Agent service. 
Exit – closes CommView Remote Agent console. Please note that the Remote Agent service continues to run and accept 
connections from CommView. 
 
Settings  
 
Change Port – allows you to change the port number that the application listens on. 
Change Password – allows you to change the connection password. 
Language – allows you to change the interface language. 
 
 
Help 
 
Contents – launches CommView Remote Agent help. 
About – shows information about the program. 
 
Note that CommView Remote Agent can accept only one client connection at any given time. 
 
 
Controlling The Program 
 
CommView Remote Agent is a service application. This means that it starts automatically when the computer is booted up and 
runs even if no one is logged on to the system. The service can be controlled using the File menu described above. Additionally, as 
with any other service application, it can be controlled using Control Panel => Administrative Tools => Services. There you can also 
change the start-up mode (automatic/manual).  
 



 

Monitoring Traffic 
 
This chapter describes how to use CommView to connect to CommView Remote Agent and capture traffic remotely. To monitor 
network traffic on remote computers, you need to have CommView Remote Agent running on the remote host and CommView 
running on your computer. It is assumed that Remote Agent is already installed and running (see the previous chapter for 
instructions) and that you are already familiar with CommView and know how to use it. If you have no experience with CommView, 
please download it and familiarize yourself with CommView prior to using CommView Remote Agent.  
 
Using CommView to Connect to CommView Remote Agent 
 
To switch to remote monitoring mode, click File => Remote Monitoring Mode. An additional toolbar will appear in the 
CommView main window next to the main toolbar. If you are behind a firewall or proxy server, or using a non-standard Remote 
Agent port, you may need to click on the Advanced Network Settings button to change the port number and/or enter SOCKS5 
proxy server settings. 
 

 
 
Click on the New Remote Agent Connection button to establish a new connection, or click on the Load Remote Agent Profile 
toolbar button to load a previously saved Remote Agent connection profile. A previously saved profile may also be loaded from the 
New Remote Agent Connection window.  
 
A Remote Agent Connection window will appear where you can enter the IP address of the computer running CommView Remote 
Agent into the IP address input area, enter the connection password and click on the Connect button, and if the password is 
correct, a connection will be established. You will then see the Link Ready message in the status bar, and the adapter selection box 
will list the remote computer's adapters.   
 
 

 
 
Now is the best time to configure the capturing rules using the Rules tab. It's very important to configure the rules correctly so 
that the volume of traffic between the Remote Agent and CommView doesn't exceed the bandwidth limit on either side of the 
connection, or you will experience noticeable lag. Be sure to filter out unnecessary packets (see more on this topic below). You can 
also apply a custom set of capturing rules to this connection and override the current rules defined in CommView by checking the 
Override current rule set box, clicking on the Edit Formula button and entering the rules formula in the field below. The 

http://www.tamos.com/download/main/


formula syntax is the same as the one used in Advanced Rules. Once you're ready to start monitoring, select the network adapter 
from the list and click the Start Capture toolbar button. CommView allows you to save the Remote Agent Connection settings as a 
connection profile for quick and easy access in the future. Click on the Save Remote Agent profile toolbar button in the New 
Remote Agent Connection window and enter a name for the file.  
 

 
 
CommView will start to capture the remote computer's traffic as if it's your local network traffic; there is virtually no difference 
between using CommView locally and remotely. When you are done with remote monitoring, just click on the Stop Capture 
toolbar button. You can then change the adapter or disconnect from Remote Agent by clicking the Disconnect toolbar button. To 
return to the standard mode, click File => Remote Monitoring Mode, and the additional toolbar will disappear. 
 
Please note that CommView can work with multiple Remote Agents simultaneously. You can open several remote connections, each 
having its own settings and an independent set of rules and collect the traffic from remote network segments in one CommView 
instance.  
 
 
How to Use CommView Remote Agent Efficiently 
 
We encourage you to pay special attention to setting the capturing rules (the Rules tab in the CommView main window, or in the 
Remote Agent window using Advanced Rules syntax) to best suit your monitoring needs. The bandwidth that you use to connect to 
the remote computer has limits; in many cases, if CommView Remote Agent is installed on a computer with high network payload, 
it can take up all available bandwidth trying to transmit all packets to the computer running CommView. If you do not set the 
capturing rules carefully to filter out the traffic that you do not need to see, it is likely that the channel that connects CommView 
and CommView Remote Agent computer might be overloaded. For example, even if you are connecting to the CommView Remote 
Agent via T1 or T3 channel (1.5 or 4.5 Mb/s correspondingly), the remote computer may be connected to the local area network at 
100 Mb/s; therefore, under a heavy load your bandwidth will be far from adequate to transmit all the remote LAN traffic being 
captured.  
 
If CommView Remote Agent captures more data than it can send to CommView, it used an internal buffer to store the packets that 
cannot be sent immediately. The buffer size is 5Mbytes. The Buffer utilization indicator in the Remote Agent window shows the 
current status of the buffer. For example, if the program has buffered 2.5 Mbytes of data, the buffer utilization is 50%. If/when the 
buffer utilization reaches 100%, the program stops buffering data and discards captured packets until some buffer spaced is freed. 
To avoid data loss, you should set the capturing rules so that the buffer is never full. 
 
Security 
 
CommView Remote Agent was made with security in mind. It can be accessed only by using a password that is never transmitted in 
plain text and that is ensured by using a challenge-response protocol with a secure hash function. If the authentication is 
successful, all transmitted traffic is compressed and then encrypted with the same password. Please take precautions to keep your 
password secret. Once it is revealed to an unauthorized person, that person will have broad capabilities to study your network and 
intercept network traffic on the remote computer.  
 



 

Information 
 

How to Purchase CommView Remote Agent 
 
This program is a 30-day evaluation version; please visit our Web site for pricing and ordering information. 
 
As a registered user, you will receive: 
 

• Fully functional, unrestricted copy of the software 
• Free updates that will be released within 1 year from the date of purchase 
• Information on updates and new products 
• Free technical support 

 
We accept credit card orders, orders by phone and fax, checks, purchase orders, and wire transfers. Prices, terms, and conditions 
are subject to change without notice: please check our web site for the latest product offerings and prices. 
 
http://www.tamos.com/order/ 
 
 

http://www.tamos.com/order/
http://www.tamos.com/order/


 

Contacting Us 
 
Web 
 
http://www.tamos.com 
 
 
E-mail 
 
 
sales@tamos.com (Sales-related questions)  
support@tamos.com (All other questions)  
 
 
Mail and Fax 
 
Mailing address: 
 
TamoSoft 
PO Box 1385 
Christchurch 8140 
New Zealand  
 
Fax: +643 359 0392 (New Zealand) 
Fax: +1 917 591-6567 (USA) 

http://www.tamos.com/
mailto:sales@tamos.com
mailto:support@tamos.com


 

Other Products by TamoSoft 
 
CommView  
 
CommView is a program for monitoring Internet and Local Area Network (LAN) activity, capable of capturing and analyzing network 
packets. It gathers information about data passing through your dial-up connection or Ethernet card and decodes the analyzed 
data. With CommView you can see the list of network connections and vital IP statistics and examine individual packets. IP packets 
are decoded down to the lowest layer with full analysis of the main IP protocols: TCP, UDP, and ICMP. Full access to raw data is 
also provided in real time. CommView is a helpful tool for LAN administrators, security professionals, network programmers, or 
anyone who wants to have a full picture of the traffic going through one's PC or LAN segment. 
 
More information 
 
 
CommView for WiFi 
 
CommView for WiFi is a powerful wireless network monitor and analyzer for 802.11 a/b/g networks. Loaded with many user-friendly 
features, CommView for WiFi combines performance and flexibility with an ease of use unmatched in the industry. CommView for 
WiFi captures every packet on the air to display important information such as the list of access points and stations, per-node and 
per-channel statistics, signal strength, a list of packets and network connections, protocol distribution charts, etc. By providing this 
information, CommView for WiFi can help you view and examine packets, pinpoint network problems, perform site surveys, and 
troubleshoot software and hardware. 
 
More information 
 
 
NetResident  
 
NetResident is an advanced network content monitoring program that captures, stores, analyzes, and reconstructs network events 
such as e-mail messages, Web pages, downloaded files and instant messages. NetResident uses advanced monitoring technology to 
capture the required data from the network, saves it to a database, reconstructs it, and displays this content in an easy-to-
understand format. While NetResident is similar to network analyzers in many respects, it focuses on high-level protocols that are 
used to transfer content over the Internet or LAN. With NetResident, you don't need a profound understanding of networking 
technologies, have to use complex packet capturing and analysis software, or dig through network packets in order to reconstruct 
the actual data; NetResident does all the work for you and presents only the Web pages, e-mails, instant messages, or downloaded 
files as requested. NetResident is used by network administrators to enforce IT policy, parents to monitor their children's 
communication on the Internet, and by forensic experts to gain crucial information. 
 
More information 
 
 
SmartWhois 
 
SmartWhois is a handy utility for obtaining information about any IP address, hostname, or domain in the world. Unlike standard 
whois utilities, it automatically delivers information associated with an IP address or domain, no matter where it is registered 
geographically. In just a few seconds, you get all you want to know about a user: domain, network name, country, state or 
province, and city. Even if the IP address cannot be resolved to a hostname, SmartWhois won't fail! 
 
More information 
 
 
CountryWhois  
 
CountryWhois is a utility for identifying the geographic location of an IP address. CountryWhois can be used to analyze server logs, 
check e-mail address headers, identify online credit card fraud, or in any other instance where you need to quickly and accurately 
determine the country of origin by IP address. 
 
More information 
 
 
Essential NetTools 
 
Essential NetTools is a set of network tools useful in diagnosing networks and monitoring your computer's network connections. It's 
a Swiss Army knife for everyone interested in a set of powerful network tools for everyday use. The program includes a NetStat 
utility that shows your computer's network connections and open ports and maps them to the owning application. It also features a 
fast NetBIOS scanner, a NetBIOS Auditing Tool for checking LAN security, and a monitor of external connections to your computer's 
shared resources, as well as a process monitor that displays information about all the programs and services running on your 
computer. Other useful tools are included, such as Ping, TraceRoute, and NSLookup. Additional features include report generation 
in HTML, text, and comma delimited formats and a customizable interface. The program is an easy-to-use and powerful 
replacement for such Windows utilities as nbtstat, netstat, and NetWatcher. It incorporates many advanced features that standard 
Windows tools can't offer. 
 
More information 

http://www.tamos.com/products/commview/
http://www.tamos.com/products/commwifi/
http://www.tamos.com/products/netresident/
http://www.tamos.com/products/smartwhois/
http://www.tamos.com/products/countrywhois/
http://www.tamos.com/products/nettools/


 
 
DigiSecret 
 
DigiSecret is an easy-to-use, secure, and powerful application for file encryption and sharing. It utilizes strong and time-proven 
encryption algorithms for creating encrypted archives, self-extracting EXE files, and sharing files with your associates and friends. 
DigiSecret also includes powerful and intelligent file compression; you no longer need .zip files when you can have encrypted and 
compressed DigiSecret files. The program is integrated with the Windows shell, and you can perform operations on files by right-
clicking on them. It also fully supports drag-and-drop operations. 
 
More information 
 
CommTraffic  
 
CommTraffic is a network utility for collecting, processing, and displaying traffic and network utilization statistics for network 
connections, including LAN and dial-up. It shows traffic and network utilization statistics for each computer in the segment. The 
software provides a very attractive and customizable interface, with an optional tray icon menu that displays general network 
statistics. You can also generate reports that reflect the network traffic volume and Internet connection expenses (if any). 
CommTraffic supports virtually any rate plan your ISP might use, such as the one based on connection time, traffic volume, time of 
the day, and other measures. You can set alarms that will inform you when certain criteria (e.g. amount of traffic, expenses) are 
reached. A configuration wizard will guide you through the setup and automatically detect your network or connection settings.  
 
More information 
 

http://www.tamos.com/products/digisecret/
http://www.tamos.com/products/commtraffic/
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